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To schedule a meeting with the Live Meeting Manager

1. Log on to Live Meeting Manager using your Live Meeting user 
login and password.This information, along with the URL for your 
Live Meeting conference center, is available from your Live 
Meeting account administrator.

2. On the My Home page, in the Meet area, click Schedule Meeting.

3. Click Attendees to select the attendees you want to invite from 
the Live Meeting address book, and then click Presenters to select 
the presenters you want to invite. For participants who do not 
appear in the address book, you can type each user’s full e-mail 
address (for example, someone@example.com) in the Attendees
or Presenters box.

4. Type the meeting title in the Subject box.

5. Select the start and end dates and times.

6. Click Time Zone to set the time zone.

7. In the Occurrence box, click One Time (occurs once only),
Recurring (occurs on a regular schedule with a specified end 
date), or Ongoing (no end date enforced).

8. To override the default scheduled meeting options for this 
meeting only, click Meeting Options, and then make the necessary 
changes. For more information, see How to Set Meeting Options.

9. In the Message text box, type the custom message that you want 
to appear in the invitation.

10. Click Send Invitations to send the invitations to the invitees.

Live Meeting sends a separate meeting invitation to each of the presenters
and attendees you invited.The invitation contains your personal 
message if you provided one, the standard Live Meeting greeting text set 
by your Live Meeting account administrator, and the meeting details that
each participant will need in order to join the meeting. Invitees also receive
a calendar item that they can add to their calendars.
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When you receive an e-mail invitation to a meeting, the invitation contains
the information that you need to get access to the meeting and to connect
to the audio portion of the meeting.The invitation may be for a future
(scheduled) meeting, or it may be for an informal Meet Now meeting,
where someone has just sent you an invitation to meet in a virtual work-
space.

To join a meeting from an e-mail invitation

1. In the e-mail invitation, click the Join Meeting link to go to the 
Live Meeting Join Meeting page.

2. At the Join Meeting page, you may be required to enter the 
following information:

: In the Your Name box, type the name you want to display in the 
Live Meeting console for other participants to identify you during 
the meeting.

: In the Meeting ID box, type the ID of the meeting that you are 
joining. If the meeting organizer requires a meeting key, type it in the 
Meeting Key box.The meeting ID and the meeting key, if required,
are contained in the e-mail invitation that you received for the 
meeting.

3. Click Join Meeting.
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You use the Live Meeting console to view and participate in meetings.

When you attempt to join a meeting and you either have not installed the
Live Meeting console or your console is out of date, you will see the
Meeting Installer page.The Meeting Installer page contains links to console
installation options. If you are using a computer running Microsoft
Windows, click Install the Windows-based Live Meeting Console.This is a
one-time installation that will set up the full-featured Live Meeting
Windows-based console on your computer.

To install the Live Meeting Console

1. In the e-mail invitation that you receive to join a Live Meeting 
session, click Join Meeting.

2. On the Meeting Installer page, click Install the Windows-based 
Live Meeting Console.

3. In the File Download dialog box, click Run. If you are running 
Windows XP SP2, you may notice that nothing happens. If this is 
the case, on the Meeting Installer page, look for a pop-up message.
Click the pop-up message, and then click Download File.

4. If you are running Windows XP SP2, click Run again at the Internet 
Explorer Security Warning dialog box to start the Live Meeting 
setup program.When installation is complete, Live Meeting will start
the console and add you to the meeting.

To join a Live Meeting with ActiveX settings locked down

The Live Meeting console does not require that your browser be enabled
to install and run ActiveX controls. If your Web browser is configured to
prevent you from downloading signed ActiveX controls or from initializing
and scripting ActiveX controls marked as safe, you will see an interim
Meeting Entry page.To join the meeting, click the Join Live Meeting link.
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Meet Now meetings are a useful alternative to traditional scheduled Live
Meeting sessions.With Meet Now, you create a "virtual office" to which you
can invite meeting participants at a moment's notice, for example, to pres-
ent information, to collaborate on documents, or to share an application
from your computer.

Before you start using Meet Now, make sure that your Live Meeting
account and your Meet Now options are set up. For more information
about setting up Live Meeting, see How To Set Up Live Meeting. For more
information about Meet Now options, see How to Set Meeting Options.

Start a Meet Now meeting from the Live Meeting Manager

1. In your Internet Browser, enter the URL of your Live Meeting 
conference center. If you do not know the URL of your conference 
center, contact your Live Meeting account administrator.

2. On the Login to Live Meeting Manager page, enter your user 
login in the User Login box, and then enter your password in the 
Password box. If you do not know your user login or your 
password, contact your Live Meeting account administrator.

3. Click Login or press the Enter key.

4. On the My Home page, under Meet, click Meet Now.

5. When the meeting console is displayed, you can invite participants 
to the meeting. On the Attendees menu in the Live Meeting 
console, click Send E-Mail Invite.

6. In the Attendees box, enter the e-mail addresses of the meeting 
participants who you want to attend the meeting as attendees. In 
the Presenters box, enter the e-mail addresses of the participants 
who you want to invite as presenters.

7. In the message body, type any additional information that you want 
to send about the meeting. Live Meeting automatically appends the 
meeting URL and phone conferencing information to the invitation.

8. Click Send Message to send the invitation.

9. Live Meeting displays the Live Meeting Console.You are now ready 
to conduct the meeting.
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Importing documents is a useful way to share information and collaborate
with others during a Meet Now meeting.You can import any document that
was created using a Microsoft Office application or any other application
that supports printing.

To import a document into the Live Meeting console

1. On the Live Meeting Share menu, choose one of the following:

: Share Document to Edit
: Share Document to View

Then, browse and select the document you want to share, and then click
Open.

2. If the document requires conversion to Microsoft Office Document 
Image (MODI) format, Live Meeting displays a message describing 
this step. Click Continue, and then wait for the document to be 
imported to the Live Meeting console.

3. To display the document, in the Resources pane on the left-hand 
side of the console, click the document that you want to share. If 
the document contains multiple parts (for example, several slides 
in a presentation), each part is displayed in the Thumbnails pane.

Now that the document is loaded and phone conferencing is set up, you 
are ready to meet with meeting participants. For more information about
conducting a meeting, see How To Conduct a Meeting.
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After you have started a Meet Now meeting, you can use the Live Meeting
console to invite others to join you.

To send a meeting invitation from within the Live Meeting console

1. From the Attendees menu in the Live Meeting console, click Send 
E-Mail Invite.

2. In the Attendees and Presenters text boxes, enter the full e-mail 
addresses of the attendees and presenters you want to invite (for 
example, someone@example.com).

3. Enter a subject for your meeting.

4. If you want, in the Message text box, type a message about the 
meeting.This message is included with the invitation.

5. Click Send Message, and then click OK.
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The Live Meeting console is made up of multiple panes.You can view or
hide panes for any meeting. Many panes have buttons that you use to 
perform tasks. For example, the Now Presenting pane provides a check 
box to lock control for content display.

As the organizer of a meeting, you can control which panes you want 
to enable or disable for other participants at your meeting. For more 
information, see How to Set Meeting Options.

To hide and show panes in the Live Meeting console

: On the View menu, point to Panes, and then click the pane that you
want to show or hide.A check mark indicates that a pane is currently
shown.
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The Attendees pane lists participants' names, their "mood," whether chat
with them is blocked, and whether they are a presenter or attendee.You
can search for a participant, or you can sort the list that appears.

To see who is attending your meeting

1. If the Attendees pane does not already appear in your Live Meeting 
console, on the View menu, click Panes, and then click Attendees.

2. To sort the list of participants, select an option in the Arrange by
list. For example, to sort alphabetically by participant name, click 
Name in the Arrange by list.

3. To find an attendee, in the Search list for person box, type the first 
few letters or the name of the person you want to locate.As you 
type, the Attendees pane updates the list to match your criteria.
The more characters of the person's name that you enter, the more
precise the match.

To make an attendee a presenter

1. In the Attendees pane, click the name of the attendee you want 
to make a presenter.

2. Click the right arrow next to the attendee's mood color.

3. In the attendee's information box, click the right arrow, and then 
click Make a Presenter.

To invite more people to your meeting

1. In the Attendees pane, click Send E-mail Invite.

2. In the Attendees field of the Send E-mail Invite dialog box, type 
the full e-mail addresses of all those invited as attendees, separated 
by semicolons. In the Presenters box, type the full e-mail addresses 
of all those invited as presenters, separated by semicolons.

3. Type a message, if you wish, and then click Send Message.
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Use the Question Manager to view questions from participants and to provide your
responses.Attendees can send questions to any presenter, and the presenter can respond
either privately or with an answer that appears to all attendees.

Note: The Questions and Answers pane is available only if the presenter allows attendees to 
ask questions.

To enable questions for a meeting

1. In the Attendees menu, click Attendee Permissions.

2. In the Attendee Permissions dialog box, select the Ask questions check box.
The Questions and Answers pane will appear in the Live Meeting console.

To display or hide the Questions and Answers pane

: In the View menu, point to Panes, and then click Questions and Answers. If 
a check mark appears beside the menu item, the pane is shown. If not, the 
pane is hidden.

To display the Question Manager

: In the Questions and Answers pane, click Question Manager. The Question
Manager appears, listing all questions received from attendees.

To respond to a question, a presenter can do the following:

: Answer the question either by sending a text response to 
all of the attendees or by sending a private text message to 
an individual attendee.

: Initiate a 1-on-1 chat with the questioner to discuss the 
issue.

: Not respond at the current time.
: Dismiss the question.
: Allow the questioner to address the entire audience by 

taking the floor.

Note: If multiple presenters are working together to monitor questions, each 
presenter's actions in the Question Manager are automatically reflected in the all 
presenters' Question Managers. For example, if one presenter dismisses a question,
it is also removed from the other presenters' Question Managers.
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To respond to a question from an attendee

1. If the Question Manager is not visible, display it as explained earlier 
in this topic.You can sort the list of questions by whether the 
question is marked, whether the person asking the question has 
the floor, alphabetically by either the asker's name or the text of 
the question, or by the time the question was posted.To do so,
click the appropriate column heading. Click the column heading 
again to toggle between an ascending and descending sort.

2. In the Question Manager, click the question that you want to 
answer, and then do one of the following:

: To give the asker the floor, click Give the Floor.
: To chat one-on-one with the asker, click Chat 1:1.
: To answer the question publicly, in the Your Answer box,

enter your response, and then click Post to All.
: To answer the question privately, in the Your Answer box,

enter your response, and then click Post Privately.

Note: As a Presenter, you can always see who asked each question.When you
choose the Post to All option, the question appears anonymously to all participants.

To ask a question

1. In the Questions and Answers pane, type your question in the 
one-line box at the bottom of the pane, and then click Ask.

2. After asking a question, you can also do the following:
: Edit the question. Click Edit, make your changes, and 

then click Ask.
: Delete the question. Click Delete.

To view and save a question log for your meeting

1. In Question Manager, click View Log.All of the question and answer 
activity from your meeting will be displayed in a separate browser 
window.

2. To save the question log, use your browser to save the HTML page 
containing the log, or open a text editor, paste the contents of the 
log to a new file, and then save the file.
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Chats are a useful way for presenters to communicate with attendees or presenters during a
meeting, such as when a presenter suggests a break-out session to discuss a specific issue
with another attendee.

In some circumstances, you might want to allow attendees to text chat with one another.
Participants can conduct separate conversations away from the larger group.When chatting 
is enabled, each participant can have multiple one-on-one chat sessions open simultaneously.
Any participant can block individual participants from chatting with them by right-clicking the
name of the participant in the Attendees pane and then clicking Block Chat.

As a presenter, you can always chat with meeting participants.You can also control whether
participants can chat among themselves.

To control attendees chatting with each other

1. On the Attendees menu, click Attendee Permissions.

2. In the Attendee Permissions dialog box, if the Interact check 
box is cleared, select it. If the box has a check mark or a green 
rectangle, select Chat with other attendees.

3. If you selected the Interact check box, verify that the settings for the other 
interaction options are as you want them, and change them as necessary.

4. Close the Attendee Permissions dialog box.

To chat with another attendee

1. In the Attendees pane, click the name of the person with whom 
you want to chat.

2. Click the right arrow located to the right of the person's mood color.

3. In the person's information box, click the right arrow, and then click Chat.
A Chat window appears on both your computer and the person's computer with 
whom you choose to chat.The person's name appears in the title.

4. Type your comment or question in the field at the bottom of the window, and then 
click Send.The chat between you and the other attendee appears in the field at the 
top of the window.Your chat is private and cannot be seen by other attendees.

5. When you finish chatting, close Chat.
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The meeting lobby is a place where people without an invitation can
attempt to join a meeting. It is similar to reservationless audio conferencing,
in which attendees can attempt to join a meeting at anytime regardless of
invitation status.Attendees who join a meeting by using the meeting lobby
use a different URL than the one that is included in Live Meeting invitations.

Organizers can use the meeting lobby to schedule meetings without send-
ing invitations to attendees. Meetings are simply set and joined by attendees
who enter the Meeting Lobby and wait for the meeting owner to grant
them access.As an organizer, you can request that Live Meeting send you an
e-mail notification when the first attendee arrives in your meeting lobby
and every thirty minutes thereafter for other attendees who arrive in the
meeting lobby.You can then selectively grant or deny access to each
attendee in the Meeting Lobby. If you do not respond within thirty minutes,
the attendee is denied access. Similarly, Live Meeting can send you an e-mail
notification when new attendees join the meeting while a meeting is in
progress.You can also "lock the door" to prevent such interruptions.

A common use of the meeting lobby is to provide people with spontaneous
access to your Meet Now meeting area at a time that they choose, rather
than waiting to receive an invitation from you. For example, you can include
the meeting lobby URL for your Meet Now meeting area on your business
cards and e-mail signatures. Customers or co-workers who want to request
an impromptu meeting with you can visit that URL in their browser, and
then wait up to thirty minutes for you to receive an e-mail notification and
allow or deny them access to the meeting.

You configure the meeting lobby when you set the meeting options for a
Meet Now meeting or a scheduled meeting.

To control meeting access through the meeting lobby

1. In the Attendees menu, click Meeting Lobby.

2. In the Meeting Lobby window, select attendees to whom you want 
to grant access, and then click Grant Access.

3. In the Meeting Lobby window, select attendees to whom you want 
to deny access, and then click Deny Access.
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The Seating Chart pane provides a view of the number of attendees and their ongoing
feedback. Each participant in the meeting is represented by a colored rectangle, the
color of which indicates the participant's current perception of the meeting.
This perception is referred to as the participant's mood.

Depending on the number of attendees, the configuration of the seating chart changes.
A large meeting is represented by a row of presenters and many rows of attendees.
A smaller meeting is represented by a round table surrounded by several participants
surrounding it.
Seating charts can help you gather rapid feedback from your audience as participants
change their chart colors to indicate their mood throughout the meeting.

One use of the Seating Chart is to allow participants to respond to information you
request during your presentation. For example, you might start your meeting by having
everyone change their seat color to "Yellow" if they can hear your voice and are ready
to begin.This gives you a visual representation that your audience can hear you and is
paying attention. It also gets them using the Live Meeting user interface, which keeps
them engaged.

You can use the colors of the attendee icons to:

: Check on the pace of your presentation 
: Get a quick "snapshot" of your audience 
: Let attendees tell you they have a question or concern 
: Indicate when an attendee temporarily steps away from the 

meeting

By default, the colors in the seating chart include the following descriptions:

: Green: Proceed (this color is shown by default for all 
attendees) 

: Red: Slow down 
: Blue: Speed up 
: Yellow: Need help 
: Purple: Question 

To view the seating chart for your meeting

: In the View menu, point to Panes, and then click 
Seating Chart.
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You can allow attendees and other presenters to attach annotations 
to resources during your meeting. If you imported the resource, all 
annotations stay in Live Meeting, and they do not affect the original 
document or presentation.

To allow attendees to interact and edit documents within a 
presentation

1. From the Attendees menu, select Attendee Permissions.

2. Under Allow Attendees to, select Annotate/Edit current 
page/slide.

3. Close the Attendee Permissions window.
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To set Meet Now options

1. In your Internet browser, enter the URL of the Live Meeting 
conference center. Enter your user login and password to log on 
to Live Meeting.

2. On the My Home page, click Meet Now Details, and then click 
Meet Now Options.

3. To set a specific option, click the appropriate link at the top of the 
Meet Now Options page. For details about specific options, see 
Meeting Options later in this article.

4. When you have finished setting options, click OK.The options that 
you set will apply to all future Meet Now meetings.

To set options for a scheduled meeting

1. In your Internet browser, enter the URL of the Live Meeting 
conference center. Enter your user login and password to log on 
to Live Meeting.

2. To begin setting Meeting Options, do one of the following:

: If you are setting options for a new meeting, in the My 
Home page, under Meet, click Schedule Meeting.

: If you are setting options for an existing meeting, in the My 
Home page, click the meeting for which you want to set 
options.

3. Click Meeting Options.

4. To set a specific option, click the appropriate link at the top of the 
Meeting Options page. For details about specific options, see 
Meeting Options later in this article.

5. When you have finished setting options, if you want to set these 
options as the default settings for all future scheduled meetings,
click Set As Default.

6. Click OK.
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Meeting details control information that Live Meeting uses to generate
meeting invitations, to configure the meeting space, and to help you with
bookkeeping if your organization uses billing codes to monitor Live Meeting
costs. Setting meeting details can be important if:

: You are configuring Live Meeting for the first time after it 
was installed.

: You want to change the length of your Meet Now sessions.
: You want to expand a meeting to include more people, and 

you need more simultaneous connections to the Live 
Meeting service.

To set meeting details

In the Meeting Details section of either the Meet Now Options page or
the Meeting Options page, set the following options:

: (Scheduled Meetings only) In the Meeting ID text box, type 
the ID for the meeting.

: (Scheduled Meetings only) In the Type section, click Web 
Meeting Place for collaborative meetings or for smaller 
groups so that participants can share control of the meeting,
or click Auditorium Place for formal presentations or 
meetings with larger audiences, where the presenter is in 
control, presents the slides, monitors the audience, and 
obtains feedback.

: In the Language list, click the language in which you want 
the Live Meeting console to appear.The language option also
specifies the language of meeting invitations, as well as the 
language used for descriptive data for Live Meeting 
recordings.

: (Optional) In the Bill to Code text box, enter the billing 
code associated with your use of the Live Meeting service 
within your organization.

: In the Meeting Size box, enter the maximum number of 
people that you expect to attend a meeting.

: (Meet Now only) In the Meeting Duration list, select the 
maximum length of the meeting.
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You can set entry controls to:

: Control who attends a meeting.
: Make a meeting available for a large general audience.
: Distinguish between participants who are attendees and 

those who are presenters.

To set entry control options

In the Entry Control, Presenters section of either the Meet Now Options
page or the Meeting Options page, set the following options:

: To limit attendance as a presenter to individuals who have a 
membership in your Live Meeting conference center, click
Access Control List.

: To limit attendance as a presenter to individuals who have a 
meeting key (a password), whether supplied by you or 
generated by Live Meeting, click Meeting Key.

In the Entry Control, Attendees section of either the Meet Now Options
page or the Meeting Options page, set the following options:

: To limit attendance as an attendee to individuals who have a
membership in your Live Meeting conference center, click
Access Control List.

: To limit attendance as an attendee to individuals who have a
meeting key (a password), whether supplied by you or 
generated by Live Meeting, click Meeting Key.

: To allow anyone to join a meeting, whether or not they have
a meeting key or a membership in your Live Meeting 
conference center, click Free Entry. Keep in mind that anyone
may enter as an attendee.
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You can prevent attendees from joining a Meet Now meeting before you
are ready. Presenters can always join the meeting at any time.

To set meeting entry time options

In the Meeting Entry Time section of either the Meet Now Options page
or the Meeting Options page, select the appropriate option:

: To prevent attendees from joining the meeting until 
30 minutes before the scheduled meeting time, click 
Attendees - 30 min. early, Presenters - anytime.To allow 
attendees to join the meeting whenever they want, click
Anyone - anytime.
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You can require participants to supply their e-mail address and company
name when they attempt to join a meeting.This requirement is called
extended registration.

To set extended registration options

In the Extended Registration section of either the Meet Now Options
page or the Meeting Options page, select the appropriate option:

: To require extended registration, click Request e-mail 
address and company name.To allow participants to join 
the meeting without supplying their e-mail address and 
company name, click Do not request e-mail address and 
company name.
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The meeting lobby is an area where uninvited people who would like to
join your meeting can request entry.You can set meeting lobby options for
your Meet Now meetings or for any scheduled meeting that you organize.
You can give users a URL to the meeting lobby when it is not appropriate
to send a meeting invitation. For example, you can include the meeting
lobby URL on your business cards so that users can always request access
to an ongoing Meet Now meeting. Presenters can use the meeting lobby to
control who enters the meeting, as well as the time that they enter.

To set meeting lobby options

In the Meeting Lobby section of either the Meet Now Options page or
the Meeting Options page, set the following options:

: To enable the meeting lobby for your meeting, click Enable 
Meeting Lobby for this meeting. In the Lobby greeting
box, type a message for visitors to the meeting lobby.When 
you enable the meeting lobby, you will see a meeting lobby 
URL on the Meeting Details page for Meet Now meetings.
This is the URL that you can send to people to allow them 
access to your meeting if they do not have an invitation.

: If you want Live Meeting to send an e-mail notification to 
you when individuals are waiting in the meeting lobby, click 
Enable e-mail notification from lobby attendees.
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The options listed under Additional Features on the Meet Now Options
page or the Meeting Options page are useful for enhancing participants'
meeting experience, for limiting what they can do in some circumstances,
and for demonstrating features of the Live Meeting console so that atten-
dees become familiar with them.

To set additional features

In the Additional Features section of either the Meet Now Options page
or the Meeting Options page, set the following options:

: To allow attendees to ask questions of the presenters,
select the Question and Answer Control Panel check box.

: To allow presenters to use the Live Meeting console to end 
the meeting, select the Show End Session Option in 
Console check box.

: To allow attendees to use the Live Meeting console to send 
e-mail messages to each other, select the Send e-mail to 
each other check box.

: To allow attendees to use the Live Meeting console to chat 
with each other and with presenters, select the Chat check 
box.

: To allow presenters to share programs with other 
participants, select the Application Sharing check box.
o To determine the level of control that presenters 

have over application sharing, click Never, When 
sharing a Single Application only, or When sharing 
the Desktop, Frame, or Single Application, as 
appropriate.

o To allow individual participants to request control 
of a shared program, select the Allow meeting 
participants to request control check box.

o To set the color quality of shared applications, which
can affect the performance of application sharing 
over the network, click the appropriate option from 
the How many colors to use for sharing list.

: To allow participants to print meeting content to an Adobe 
Acrobat Reader file (.pdf), click Printing to PDF.To enable 
printing for all participants or to limit it to presenters only,
click the appropriate option.
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: To make the seating chart visible to all participants, select 
the View the seating chart check box.You must also select 
this check box to edit the color-coded legend in the seating 
chart. If you want only to edit the legend, but not make the 
seating chart visible, clear the check box when you are 
finished editing the legend.
o To edit the color-coded legend in the seating chart,

change the text in the Title box and the boxes 
corresponding to the colors you want to change.

o To define a color as the default when a participant 
joins the meeting, click the color.

: To enable a custom pane in the Live Meeting console that 
contains streaming media content from a source you specify,
select the Streaming Media Custom Frame check box.
o In the Attendee URL box, enter the URL of the 

source of streaming media content for attendees. In 
the Presenter URL box, enter the URL of the 
source of streaming media content for presenters.

o You can specify the height of the custom pane for 
attendees and for presenters in the corresponding 
Frame Height boxes.
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When you set a content expiration time, all content associated with the
meeting will be deleted after the time interval you specify. Setting an expira-
tion time can be important when:

: You do not want confidential content to persist on a server 
that does not belong to your company.

: You want to delete information from your computer when 
it is no longer useful.

To set content expiration options

In the Content Expiration section of either the Meet Now Options page
or the Meeting Options page, set the following options:

: To delete content after a meeting ends, select the Meeting 
content will be deleted after the meeting ends based on 
the duration specified below check box.

: To specify the amount of time you want Live Meeting to 
retain content before deleting it, type a number in the box,
and then click a unit of time on the accompanying list.
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You can choose to record a meeting or to allow other presenters to
record it, and you can control meeting participants' access to the recording.

To set recording options

In the Recording section of either the Meet Now Options page or the
Meeting Options page, set the following options:

1. In the Enable Recording section, click one of the following options:

: To allow only yourself (as organizer) to record the meeting,
click Disabled in the meeting, but the organizer can still 
record when logged into Live Meeting.

: To allow presenters to record the meeting, click the 
Presenter can record the meeting option.

2. In the Recording Access section, click one of the following options:

: To allow only yourself and your Live Meeting account 
administrator access to recordings, click Only the 
administrator and organizer can view recordings.

: To allow all attendees and presenters at the meeting to view
recordings, click All meeting participants can view 
recordings using their meeting entry information.
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You can use Live Meeting Manager to control your personal information,
connection speed, and access to recording. If you install the Live Meeting
Add-In Pack, you can also control add-in setup and you can access user
preferences in the Start menu on your Microsoft Windows computer.

To set your user preferences in Live Meeting Manager

1. On the My Home page, under Manage, click User Preferences.

2. On the User Preferences page, enter the following information:

: In the Personal Information section, type your first name,
last name, and full e-mail address (for example,
someone@example.com).

: In the Password section, you can change your password.To 
do so, type your old password in the Old password box.
Type your new password in the New password box, and 
then type the new password once again in the Confirm new
password box.

: In the Display Options section, indicate the number of 
meetings or recordings you want Live Meeting Manager to 
display on a single page, and select your local time zone.

: In the Recording Access section, if you want to require the 
e-mail address and company name of participants who want 
to access your recordings, select the Require extended 
registration by asking for email and company name check
box.To allow anybody to download meeting recordings, or 
to allow only meeting organizers to download recordings,
click the appropriate option.

3. Click OK to save your user preferences. Live Meeting will use these
preferences for future meetings.
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To set your user preferences in the Live Meeting Console 

1. In the Tools menu, click User Preferences.

2. In the User Preferences dialog box, on the Personal Information 
tab, select the check boxes next to the contact information you 
want to display in the Attendees pane of the meetings you attend.
Then, for each field, type your contact information in the 
corresponding box.

3. On the Connection Speed tab, click the option that matches your 
network connection speed on the computer you will use for 
attending Live Meeting sessions or click the option that lets Live 
Meeting automatically detect your connection speed.

4. On the Recording Access tab, click the option that matches who 
you want to allow to download recordings of meetings that you 
organize and manage with Live Meeting. If you want to require the 
e-mail address and company name of participants who want to 
access your recordings, select the Require extended registration 
by asking for email and company name check box.

5. Click OK to save your user preferences. Live Meeting will use these 
preferences for future meetings.
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Before you record a meeting, ensure that the Recording and Audio options
are configured the way you want for both Meet Now meetings and sched-
uled meetings.

To set recording options for Meet Now meetings

1. In your Internet browser, enter the URL of your Live Meeting 
conference center.

2. On the My Home page of Live Meeting Manager, enter your user 
login in the User login box and your password in the Password 
box, and then click Login.

3. Click Meet Now Details, and then click Meet Now Options.

4. At the top of the Meet Now Options page, click Recording.

5. By default, only the meeting organizer can record a meeting. If you 
want to allow presenters to record your meeting, select Presenters
can record the meeting.

6. Under Recording Access, select how you want to control access to
viewing recordings. By default, only the administrator and organizer 
can view recordings.

To set audio options for Meet Now meetings

For the Live Meeting recording feature, you must specify additional dialing
keys in addition to the participant code and the leader code.The Live
Meeting recorder dials into the conference call as a silent attendee.You 
use additional dialing keys to input the character string needed to allow the
Live Meeting to input your participant code for you.You can instruct Live
Meeting to pause before dialing the participant code. By adding commas to
indicate pauses, you can give the phone conferencing service prompt time
to complete before Live Meeting dials the participant code.After Live
Meeting enters the participant code, it enters any other character strings
that you have specified.

: In the first Actual dialing keys box, type commas to indi-
cate how long Live Meeting should wait before proceeding with the partici-
pant code, and then in the box to the right of <participant code>, enter
any other characters that are required by the conference call service after
the participant code is entered.
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To set recording options for scheduled meetings

1. At the My Home page of the Live Meeting Manager, enter your 
user login in the User login box and your password in the 
Password box, and then click Login.

2. Under Meet, click Schedule Meeting.

3. On the Schedule Meeting page, click Meeting Options.

4. At the top of the Meeting Options page, click Recording.

5. By default, only meeting organizers can record a meeting. If you 
want to allow presenters to record the meeting, select 
Presenters can record the meeting.

6. Under Recording Access, select how you want to control access to
viewing recordings. By default, only the administrator and organizer 
can view recordings.

To set audio options for scheduled meetings

For the Live Meeting recording feature, you must specify additional dialing
keys in addition to the participant code and the leader code.The Live
Meeting recorder dials into the conference call as a silent attendee.You use
additional dialing keys to input the character string needed to allow the Live
Meeting to input your participant code for you.You can instruct Live
Meeting to pause before dialing the participant code. By adding commas to
indicate pauses, you can give the phone conferencing service prompt time
to complete before Live Meeting dials the participant code.After Live
Meeting enters the participant code, it enters any other character strings
that you have specified.

: In the first Actual dialing keys box, type commas to 
indicate how long Live Meeting should wait before proceeding with the 
participant code, and then in the box to the right of <participant code>,
enter any other characters that are required by the conference call service
after the participant code is entered.
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By default, only the meeting organizer can record a meeting, but the organ-
izer can give permission to presenters to record the meeting as described
earlier in this article.

Note: These instructions assume that you have joined the meeting as either the
organizer or as a presenter with permission to record, that you have set audio and
recording options as described earlier in this article, and that you have imported the
resources you need for the meeting.

To record a meeting

1. When the Live Meeting console starts, the Audio and Recording 
Setup dialog box appears.The Phone Conferencing information will 
be displayed in this dialog box. Call the Phone Conferencing Service 
using the telephone number supplied in the box. Be sure to supply 
your conference leader code.

2. Before recording the meeting, import the resources you want for 
the meeting. For example, you can click the Import a document 
button on the Live Meeting toolbar.You may also want to wait for 
the meeting participants to arrive before you start recording the 
meeting.

3. If you want to test the audio connection before recording, in the 
Audio and Recording Setup dialog box, click the double arrow to 
expand the recording section of the dialog box, and then click 
Test/Listen to Connection.

4. When you are ready to start recording, click Start Recording in 
the Audio and Recording Setup dialog box. If the dialog box is not 
visible, click Start Recording on the Live Meeting console toolbar.

5. To pause a recording, click the Pause button.To resume recording 
after a pause, click the Pause button again.

6. When you are finished recording, click the Stop Recording button.
To save the recording, click Save Recording.The recording is saved 
to your conference center.
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After recording the meeting, allow up to 24 hours for the recording to be
available.After the meeting recording is complete, you, as the meeting
organizer, must access the recording and provide access for others.

To access and play a recording

1. Log on to Live Meeting Manager.

2. At the My Home page, under View, click Recordings.

3. In the Recordings list, click the View icon to the left of the 
recording name in the list.

4. (Optional) To install the Replay Wrapper, a special skin for 
Windows Media Player that adds indexing ability to playback of your 
recordings, click Install Replay Wrapper and follow the instructions
on the screen.

5. In the View Recording in Replay format section, click the View
icon.
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When you set recording options before a meeting, you can either limit
access to a recording to the organizer and the Live Meeting administrator,
or you can give access to all meeting participants. If you limit access to the
organizer and the administrator, you can still provide access to individuals.
To do so, you send those individuals an invitation to view the recording.

To send an invitation to a recorded meeting

1. On the My Home page, under View, click Recordings.

2. In the Recordings list, click the title of the meeting recording for 
which you want to send invitations.

3. Optionally, you can change the recording access control and the 
download options.

4. In the Invitees box, type the full e-mail addresses (for example,
someone@example.com), separated by semicolons, of the people 
you want to invite to view the recording.

5. Type an optional message, and then click Send Invitations. Invitees 
will receive an e-mail message with a link to the recording.
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As an organizer, you can exit a meeting in one of two ways:

: Leave the meeting, but allow other participants to continue.
: Leave the meeting, and end the meeting for all participants.

To leave a meeting you have organized but allow others to contin-
ue 

: On the File menu, click Exit.

To leave a meeting and end the meeting for all participants

: On the File menu, click Exit and End Session.
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